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Análisis de Agua Subterránea 
Transitoria con Estabilidad del 

Talud 
 
 

Este tutorial describe cómo utilizar el Slide para calcular los factores 
de seguridad para una presa sujeta al cambio tiempo - dependiente de 
la presión de los poros. Como parte del tutorial, se lleva a cabo un 
análisis de agua subterránea transitoria, utilizando elementos finitos. 
 
 
Se puede encontrar el producto terminado de este tutorial en el archivo 
de datos Tutorial 19 Transitorio + Estabilidad del Talud.slim 
(“Tutorial 19 Transient + Slope Stability.slim”) Se puede acceder a 
todos los archivos del tutorial instalados con el Slide 6.0, al seleccionar 
Archivo > Carpetas Recientes>Carpeta de Tutoriales (“File > Recent 
Folders > Tutorials Folder”) desde el menú principal del Slide. 
 
 
Temas Desarrollados 
 

• Análisis de filtración de agua subterránea transitoria 
 
• Estabilidad del talud con agua subterránea transitoria  

 
 
 
Geometría 
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Modelo (“Model”)______________________________________________ 

 
 

Inicie el programa Modelo (“Model”) del Slide.  
 
Parámetros del Proyecto (“Project Settings”) 
 
Abra la ventana de diálogo Parámetros del Proyecto (“Project 
Settings”) desde el menú Análisis (“Analysis”). Configure las 
Unidades de Tensión (“Stress Units”) a Métrico (“Metric”), configure las 
Unidades de Tiempo (“Time Units”) a Días (“Days”) y las Unidades de 
Permeabilidad (“Permeability Units”) a metros/segundos. Configure la 
Dirección de Falla (“Failure Direction”) de Izquierda (“Left”) a Derecha 
(“Right”), tal como se muestra. 
 
 
 

 
 
Haga clic en el enlace Agua Subterránea (“Goundwater”) en el lado 
izquierdo. Para el Método elija Estado Estacionario FEA (“Steady 
State”). Seleccione la casilla de selección Avanzado (“Advanced”) y 
elija el Agua Subterránea Transitoria (“Transient Groundwater”). 
 
. 
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El Método (“Method”) se refiera al método utilizado para 
obtener el estado inicial para el análisis de agua subterránea 
transitoria. En este tutorial llevaremos a cabo un análisis de 
elemento finito para obtener el estado inicial. 
 
Ahora, haga clic en el enlace Transitorio (“Transient”) en la 
izquierda. En esta parte necesitamos especificar los tiempos en 
lo que deseamos observar los resultados de la presión de poros. 
Cambie el Número de Etapas (“Number of Stages”) a 5. Ingrese 
los tiempos para cada etapa, tal como se muestra. Asimismo, 
seleccione la casilla de selección Calcular SF (Factor de 
Seguridad (“Safety Factor”)) para casa etapa. 
 
 

 
 
Esto configurará el modelo para calcular el factor de seguridad 



Slide v.6.0 Manual del Tutorial 

Transient Groundwater Analysis with Slope Stability 19-4  

 

en cada tiempo específico, debido a que las condiciones de agua 
subterránea están cambiando. 
 
 
Haga clic en OK para cerrar la ventana de diálogo Parámetros 
del Proyecto (“Project Settings”). 
 
 

Estabilidad del Talud (“Slope Stability”)_______________________ 
 
 

Ahora, usted verá una pantalla en blanco con tres tabuladores 
en la parte inferior. Uno para la Estabilidad del Talud (“Slope 
Stability”), uno para Estado Estacionario del Agua Subterránea 
(“Steady State Groundwater”) y otro para el Agua Subterránea 
Transitoria (“Transient Groundwater”). La primera parte de 
este tutorial incluye la configuración del modelo de geometría. 
Sólo se puede hacer esto en el modo Estabilidad del Talud 
(“Slope Stability”), al hacer clic en el tabulador para 
Estabilidad del Talud (“Slope Stability”). 
 
 
Límites (“Boundaries”) 
 
Este modelo representa una presa subyacente a una 
cimentación fuerte reteniendo agua estancada en una parte. En 
esta parte definiremos la geometría del problema. 
 
Asegúrese de que se encuentre en la vista “Estabilidad del 
Talud” (“Slope Stability’”). Seleccione la opción Añadir Límite 
Externo (“Add External Boundary”) en el menú Límites 
(“Boundaries”) e ingrese las siguientes coordenadas: 
 

0 , 0 
 
100 , 0 
 
100 , 10 
 
75 , 10 
 
55, 20 
 
51 , 22 
 
44 , 22 
 
20 , 10 
 
0 , 10 
 
c (para cerrar límite) 

 
Presione Ingresar (“Enter”) para finalizar los puntos de 
entrada. El modelo lucirá así: 
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Ahora, necesitamos definir el límite entre el material de la 
presa y la cimentación. Seleccione Límites → Añadir Límite 
de Material (“Boundaries → Add Material Boundary”). 
Haga clic en el punto (0,10) y luego en el punto (100,10). 
Presione Ingresar (“Enter”) para detener la entrada de puntos. 
El modelo lucirá así. 
 
 

 
 
Materiales (“Materials”) 
 
Seleccione Definir Materiales (“Define Materials”) desde el 
menú Propiedades (“Properties”). Cambie el nombre de 
Material 1 a Presa (“Dam”). Configure a 6 kN/m2 y φb to 35°, 
tal como se muestra. 
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Los parámetros de estabilidad del talud se pueden configurar 
sólo si se encuentran en el modo Estabilidad del Talud (“Slope 
Stability”). Luego configuraremos los parámetros de flujo del 
agua subterránea. 
 
Haga clic en el enlace para el Material 2. Cambie el nombre a 
Cimentación. Configure la Cohesión (“Cohesion”) a 15 kN/m2 y 
configure φ y φb a 30 grados, tal como se muestra. 
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Haga clic en OK para cerrar la ventana de diálogo.  
 
 
 
Asignar Propiedades (“Assigning Properties”) 
 
Por defecto, se asigna al modelo completo el Material 1 (Presa). 
Para configurar el material de cimentación, elija Propiedades 
→ Asignar Propiedades (“Properties → Assign 
Properties”). Elija Cimentación (“Foundation”) y haga clic 
dentro de la parte inferior del modelo. Cierre la ventana de 
diálogo Asignar Material (“Assign Material”) y el modelo debe 
lucir así. 
 

 
 
Usted podrá solo hacer clic derecho dentro del área de la 
cimentación y elegir Asignar Material → Cimentación (“Assign 
Material → Foundation”). 
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Superficies de Falla (“Slip Surfaces”)  
 
En este tutorial, deseamos restringir la búsqueda para 
superficies de falla, con el fin de incluir sólo superficies de falla 
mayores que se extiendan desde la parte superior de la presa 
hasta la parte inferior. Para realizar esto, necesitamos añadir 
otro conjunto de Límites del Talud (“Slope Limits”). 
 
Diríjase a Superficies → Límites del Talud→ Definir 
Límites (“Surfaces → Slope Limits → Define Limits”). 
Haga clic en el recuadro para Segunda Serie de Límites 
(“Second set of Limits”), tal como se muestra. 
 

 
 
En esta parte es posible especificar las coordenadas de los 
límites, pero es más fácil hacer esto de forma gráfica, al 
arrastrarlos por toda la superficie del talud; por consiguiente, 
haga clic en OK para cerrar la ventana de diálogo. Ahora, usted 
observará los dos conjuntos de los límites del talud en el 
modelo. 
 
Deseamos superficies de falla posibles para iniciar desde la 
parte superior de la presa. Entonces, haga clic derecho en el 
ícono límite del talud en x=33 (segundo desde la izquierda) y 
seleccione Mover Límites (“Move Limits”). Ahora, arrastre el 
ícono al lado derecho de la parte superior plana de la presa, tal 
como se muestra. 
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Ahora, arrastre el ícono izquierdo en x=0 a la parte superior 
izquierda de la presa. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Finalmente, arrastre el ícono que está a la mitad del talud en 
x=66 a l aparte inferior del talud. Presione Ingresar (“Enter”) 
para terminar de mover los límites y el modelo debe lucir así: 
 
 

 
 
Ahora, que se han definido los límites del talud, necesitamos 
especificar cómo el Slide debe buscar posibles superficies de 
falla. Diríjase a Superficies → Opciones de Superficies. En 
el Método de Búsqueda (“Search Method”), elija Búsqueda 
Avanzada (“Auto Refine Search”). Esta opción significa que no 
tenemos que delimitar una cuadrícula de búsqueda. 
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Haga clic en OK para cerrar la ventana de diálogo.  

 
Agua Subterránea (“Groundwater”)__________________________ 

 

 
Ahora, es momento de configurar el modelo del 
elemento finito para calcular el comportamiento del 
agua subterránea. Primero, configuraremos el estado 
inicial que existe antes del descenso del nivel; por lo 
tanto, seleccione el tabulador Estado Estacionario de 
Agua Subterránea (“Steady State Groundwater”) 
en la parte inferior de la pantalla. 
 
 
Generar Malla (“Mesh”) 
 
Antes que podamos configurar las condiciones del 
límite, necesitamos crear una malla de elemento finito. 
Se puede realizar esto de fácilmente, al seleccionar 
Malla → Discretice y Genere Malla. Ahora, el 
modelo debe lucir así: 
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Condiciones del Límite (“Boundary 
Conditions”) 
 
Configuraremos las condiciones del límite paa simular 
el agua estancada en el lado derecho. 
 
Seleccione Malla → Configure Condiciones de 
Límite (“Mesh → Set Boundary Conditions”)  
Para el tipo BC, elija la Altura Manométrica Total 
(“Total Head”) y configure el valor de la Altura 
Manométrica Total (“Total Head”) a 20 m. No coloque 
check en el recuadro de “Aplicar al estado estacionario 
Y análisis transitorio” (‘Apply to steady state AND 
transient analysis’) 
 
 

 
 
Haga clic en el lado derecho del talud cerca a la parte 
inferior, y en la parte superior de la capa de 
cimentación a la derecha de la presa. Haga clic en 
Aplicar (“Apply”). Haga clic en Cerrar (“Close”) para 
cerrar la ventana de diálogo. El modelo debe lucir como 
sigue: 

 
 
Condiciones del Límite Transitorio 
(“Transient Boundary Conditions”) 
 
El modelo de agua estancada que se muestra 
anteriormente representa el estado inicial. Ahora, 
implementaremos las condiciones del límite transitorio 
para simular un descenso del nivel gradual del nivel del 
agua. 
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 Haga clic en el tabulador Agua Subterránea 
Transitoria (“Transient Groundwater”) en la parte 
inferior de la pantalla. Seleccione Malla → Configurar 
Condiciones de Límite Transitorio (“Mesh → Set 
Transient Boundary Conditions”). En esta parte, 
configuremos una función que cambiará las condiciones 
del límite con el tiempo. Haga clic en el botón Nuevo 
(“New”). Cambie el nombre a “Descenso del Nivel 
Gradual” y configure el Tipo a Altura Manométrica 
Total con Tiempo (“Total Head with Time”). Ahora, 
llene dentro de los valores de Tiempo (“Time”) y Altura 
Manométrica Total (“Total Head”), tal como se muestra 
a continuación: 
 

 
 
Haga clic en Ok. Ahora, haga clic en la parte inferior 
derecha del talud y en la parte superior de la capa de 
cimentación, como anteriormente. Haga clic en Aplicar 
(“Apply”). El modelo debe lucir como esto:  

 
 
Haga clic en Cerrar (“Close”) para cerrar la ventana de 
diálogo. Ahora, el gráfico muestra la altura del agua 
estancada en la última etapa del análisis. 
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Propiedades del Material (Agua 
Subterránea) (“Material Properties 
(Groundwater)”) 
 
Seleccione Propiedades → Definir Propiedades 
Hidráulicas (“Properties → Define Hydraulic 
Properties”). Las propiedades hidráulicas requeridas 
para un análisis transitorio son las mismas que las 
requeridas por un análisis de estado estacionario, con 
excepción de que se debe especificar el contenido del 
agua (WC).    
Haga clic en el enlace para el material de la Presa 
(“Dam”). Para el Modelo (“Model”), elija Simple 
(“Simple”). Esta es una función integrada que relaciona 
a la permeabilidad y el contenido del agua con la 
succión matricial. Para visualizar las relaciones, haga 
clic en el ícono gráfico de la derecha. Configure la 
permeabilidad Ks para que sea 1e-5 m/s. Deje el 
contenido del agua WC, como el valor de defecto de 0,4. 
La ventana de diálogo debe aparecer como sigue. 

 
 
 

 
 

 
Haga clic en el enlace para el material Cimentación 
(“Foundation”). Configure Ks a 1e-8 m/s. 
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Haga clic en OK para cerrar la ventana de diálogo.  
 
Computar (Compute) 
 
Guarde el modelo, utilizando la opción Guardar Como 
(“Save As”) en el menú Archivo (“File”). Ahora, usted 
puede elegir Computar (“Compute”) (agua subterránea) 
desde el menú Análisis (“Analysis”) para llevar a cabo el 
análisis de agua subterránea. Sin embargo, en este 
tutorial, deseamos que se computen ambos resultados, 
tanto el de agua subterránea, como el de estabilidad del 
talud. Por lo tanto, seleccione el tabulador en la parte 
inferior Estabilidad del Talud (“Slope Stability”). 
Ahore, seleccione Análisis → Computar (“Analysis → 
Compute”). Esto computará ambos resultados de agua 
subterránea y estabilidad del talud. Podría tomar unos 
minutos realizar el cálculo. Cuándo haya finalizado, 
elija Interpretar (“Interpret”) (agua subterránea) 
desde el menú Análisis (“Analysis”) para visualizar los 
resultados. 
 
 
Interpretar (Interpret) 
 
Ahora, usted verá la presión de cabeza para el estado 
inicial. Asimismo, para mostrar el factor de seguridad, 
haga clic en el botón Estabilidad del Talud y Agua 
Subterránea (“Slope Stability and Groundwater”) de la 
barra de herramientas. 
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Usted puede ver que el talud está bastante estable en 
este momento. 
Haga clic a través de otras etapas, utilizando los 
tabuladores en la parte inferior. Usted verá como la 
presión de cabeza cambia mientras la napa freática se 
reduce. Después de 6 días, el agua estancada ha 
alcanzado su profundidad final (4 m sobre la 
cimentación), pero la presión de cabeza continúa 
cambiando mientras el agua fluye desde las regiones de 
presión alta hasta las de presión baja. 
 
 
Haga clic en el tabulador para la Etapa 5 (50 días).Esto 
representa básicamente el estado estacionario. Se puede 
observar el progreso de la napa freática con el tiempo, al 
dirigirse a Visualizar→ Desplegar las Opciones 
(“View → Display Options”). Seleccione el tabulador 
Agua Subterránea (“Groundwater”) y mediante el 
agua de FEA, seleccione Todas las etapas, tal como se 
muestra a continuación. 
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Haga clic en Hecho (“Done”). Ahora, se grafican las 
napas freáticas como líneas punteadas rosadas en las 
diferentes etapas. Esas líneas son difíciles de ver en 
este gráfico, por ende cambie el gráfico a mostrar 
contornos de la altura manométrica total, al utilizar el 
menú desplegable en la parte superior. El gráfico lucirá 
ahora así: 
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Usted puede ver que la línea rosada sólida representa la napa 
freática en 50 días y las líneas punteadas rosadas representan 
la napa freática en otras etapas. Regrese a las Opciones de 
Despliegue (“Display Options”) y desactive las napas freáticas. 
Cambie los contornos nuevamente a la Altura Manométrica 
Total. 
 
Asimismo, usted puede visualizar el factor de seguridad 
cambiante mientras que las presiones de poros cambian. 
Cuando se reduce la napa freática, el factor de seguridad 
disminuye drásticamente, ya que el peso del agua ha sido 
removido, pero el exceso de las presiones de los poros no se han 
disipado aún. A los 6 días, el factor de seguridad está sólo sobre 
1, lo que indica que el talud fallará probablemente. 
 
 

 
 
A las 50 días, la mayor parte del exceso de las presiones de los 
poros se han disipado y la presa se vuelve más estable. 
 

 
 
 
 
 
Usted puede graficar el factor de seguridad versus el tiempo, al 
dirigirse a Datos → Graficar SF con Tiempo (“Data → 
Graph SF with Time”). Usted puede elegir qué resultados del 
método graficar. Elija ambos métodos, Bishop y Janbu, tal como 
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se muestra a continuación. 
 

 
 
Haga clic en Gráfico para visualizar el gráfico. Debe verse así: 
 

 
 
En esta parte, usted puede ver claramente la rápida 
disminución en el factor de seguridad, mientras se disminuye la 
napa freática e incrementa el gradual, a medida que las 
presiones de los poros en exceso se disipan. Este ejemplo 
muestra la importancia de un análisis de agua subterránea 
transitoria, debido a que un análisis de estado estacionario 
sugeriría que la presa está estable. 
 
Esto concluye el tutorial. 

 
Ejercicios Adicionales  

 

 
En 50 días, la presa no ha alcanzado una solución de estado 
estacionaria. Pruebe añadir otra etapa (por decir 100 días) para 
ver el factor de seguridad de estado estacionario final. 

 
 


